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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may 
only be used in accordance with the license agreement.

This document is protected under copyright law. An authorized licensee of Avid Motion Graphics may reproduce this publication for 
the licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, 
for commercial purposes, such as selling copies of this document or providing support or educational services to others. This 
document is supplied as a guide for Avid Motion Graphics. Reasonable care has been taken in preparing the information it contains. 
However, this document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not 
accept responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to change 
without notice.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

Copyright © 2013 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS 
PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR 
PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION 
MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER 
RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is 
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the 
software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or 
publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, 
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING 
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are 
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and 
use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be 
used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS 
PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

http://www.avid.com/US/about-avid/legal-notices/patent-marking
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Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the 
above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting 
documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software 
without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any 
purpose. It is provided "as is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire 
notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the 
supporting documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:
© 2010 Nexidia Inc.  All rights reserved, worldwide.  Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other 
trademarks are the property of their respective owners.  All Nexidia materials regardless of form, including without limitation, 
software applications, documentation and any other information relating to Nexidia Inc., and its products and services are the 
exclusive property of Nexidia Inc. or its licensors.  The Nexidia products and services described in these materials may be covered 
by Nexidia's United States patents: 7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415, 7,475,065; 7,487,086 and/or other 
patents pending and may be manufactured under license from the Georgia Tech Research Corporation USA. 

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable 
for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of 
reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or 
consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s products or the 
software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised, 
knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this 
software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source 
Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are 
subject to copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.
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This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party 
Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection 
with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a 
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the 
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, Assistant 
Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid 
DNxHD, Avid DS Assist Station, Avid Ignite, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, Avid Mojo, Avid 
Remote Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, Beat Detective, Beauty 
Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Bruno, C|24, CaptureManager, ChromaCurve, 
ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, Command|24, Command|8, 
Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, D-Command, D-Control, Deko, DekoCast, D-Fi, D-fx, Digi 002, Digi 003, 
DigiBase, Digidesign, Digidesign Audio Engine, Digidesign Development Partners, Digidesign Intelligent Noise Reduction, 
Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, DigiSnake, DigiSystem, Digital 
Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, Do More, DPP-1, D-Show, DSP 
Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase, Expander, 
ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame Chase, FXDeko, 
HD Core, HD Process, HDpack, Home-to-Hollywood, HYBRID, HyperSPACE, HyperSPACE HDCAM, iKnowledge, Image 
Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS ControlAir, InGame, Instantwrite, Instinct, Intelligent Content 
Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, Intelli-sat Broadcasting Recording Manager, InterFX, 
Interplay, inTONE, Intraframe, iS Expander, iS9, iS18, iS23, iS36, ISIS, IsoSync, LaunchPad, LeaderPlus, LFX, Lightning, Link & 
Sync, ListSync, LKT-200, Lo-Fi, MachineControl, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee, 
MassivePack, Massive Pack Pro, Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMix, Media Reader, Media 
Recorder, MEDIArray, MediaServer, MediaShare, MetaFuze, MetaSync, MIDI I/O, Mix Rack, Moviestar, MultiShell, NaturalMatch, 
NewsCutter, NewsView, NewsVision, Nitris, NL3D, NLP,  NSDOS, NSWIN,  OMF, OMF Interchange, OMM, OnDVD, Open Media 
Framework, Open Media Management,  Painterly Effects, Palladium, Personal Q, PET, Podcast Factory, PowerSwap, PRE, 
ProControl, ProEncode, Profiler, Pro Tools, Pro Tools|HD, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, QuickPunch, 
QuietDrive, Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket 
Surfer, Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, ScriptSync, 
SecureProductionEnvironment, Serv|GT, Serv|LT,  Shape-to-Shape, ShuttleCase, Sibelius, SimulPlay, SimulRecord, Slightly Rude 
Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, SoundReplacer, SPACE, SPACEShift, SpectraGraph, SpectraMatte, 
SteadyGlide, Streamfactory, Streamgenie, StreamRAID, SubCap, Sundance, Sundance Digital, SurroundScope, Symphony, SYNC 
HD, SYNC I/O, Synchronic, SynchroScope,  Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, TimeLiner, Titansync, Titan, TL 
Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, 
tools for storytellers, Transit, TransJammer, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Video the Web Way, VideoRAID, 
VideoSPACE, VTEM, Work-N-Play, Xdeck, X-Form, Xmon and XPAND! are either registered trademarks or trademarks of Avid 
Technology, Inc. in the United States and/or other countries.
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1 Installing and Configuring Avid Motion 
Graphics Journalist

The following provides instructions for installing and configuring Avid Motion Graphics 
Journalist software and related applications.

The following main topics are described in this chapter:

• What You Need to Activate the Software License

• Setting Up the Avid Motion Graphics Journalist Server

• Installing AMG Journalist Client Software

• Setting Up the AMG Preview Renderer

• Setting Up the AMG Advanced Device Manager

• Installing the Avid Service Framework

• Setting Up the AMG Device Service

• Confirming Functionality

• Example of AMGConf.ini File for iNEWS Command
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What You Need to Activate the Software License

This section contain general steps for using Avid License Control to license AMG, AMG 
Journalist, and AMG Preview Renderer. To activate the software using the Avid License Control 
tool, you need the items listed in the following table:

c If you change your system configuration — for instance, by replacing your hard drive, a 
network adapter, or by upgrading your operating system — you must first deactivate your 
Avid software. 

n Your network administrator might need to open a few ports that are used during the license 
activation. The Avid License Control tool utilizes both port 3443 and port 443 for license request 
and response communication. Port 3443 is the primary port, but if this port is blocked, the 
Activation Service tries port 443, which is more likely to be open for Web communication.

Identification Number Type Where you can find it:

Activation ID The Activation ID is provided on an Activation ID and System ID 
card shipped with your new Avid Motion Graphics system. The 
Activation ID is used to activate the software license and has been 
linked to your System ID.

System ID The System ID is provided on an Activation ID and System ID card 
shipped with your new Avid Motion Graphics system. The System 
ID is used for expediting warranty verification and customer service. 
After activation, the License Profile tab of the Avid License Control 
tool displays information about your system. Click “Copy to 
Clipboard” to copy the information to your clipboard. You can then 
paste from the clipboard to an e-mail or create a text file. This is 
helpful if you need to save this information for your records or need 
to send system information to Avid Customer Support.

Device ID The Device ID is only needed if you are activating your software on a 
system that is not connected to the Internet. This is provided through 
the Avid License Control tool during activation.
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Setting Up the Avid Motion Graphics Journalist 
Server

After setting up and configuring the operating system settings for your Avid Motion Graphics 
system, you can set up the Avid Motion Graphics Journalist software and related applications.

Avid supplies one blank USB flash drive that can be used for installing Avid Motion Graphics 
Creation, Journalist, or News Control software.

n The Avid Motion Graphics software is available on the Avid Download Center 
(www.avid.com/support/downloadcenter).

To Install This Software See The Following Section

Avid Motion Graphics 
Journalist Server

See “Installing Avid Motion Graphics Journalist Server Software” on 
page 6.

Once installed, you need to license the software as described in 
“Licensing AMG NRCS Clients and AMG Clips” on page 12. 

Then you must configure the software as described in “Configuring the 
Avid Motion Graphics Journalist Server” on page 15.

Then, you must start the AMG Journalist Server software, as described in 
“Starting the AMG Journalist Server Applications” on page 18.

Avid Motion Graphics 
Journalist Client

See “Installing AMG Journalist Client Software” on page 18. 

AMG Preview Renderer See “Installing the AMG Preview Renderer” on page 20. 

AMG Advanced Device 
Manager

See “Setting Up the AMG Advanced Device Manager” on page 26. 

Once installed, you must configure the AMG Advanced Device Manager, 
as described in “Configuring the AMG Advanced Device Manager” on 
page 28. 

Avid Service Framework See “Installing the Avid Service Framework” on page 31. 

Once installed, you can configure the Avid Motion Graphics Device 
Service, as described in “Configuring the AMG Device Service” on 
page 39.

AMG Device Service See “Setting Up the AMG Device Service” on page 36.

Avid Motion Graphics News 
Control

See Chapter 7 the Avid Motion Graphics Setup Guide, or Chapter 2 of the 
Avid Motion Graphics News Installation Guide.
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Avid Motion Graphics Journalist Server Installation Tasks

The following steps describe how to install the Avid Motion Graphics Journalist Server (AMG 
Journalist Server) for integration with Avid iNEWS Command and Avid iNEWS newsroom 
computer system or ENPS. This assumes that the Avid Motion Graphics servers have already 
been installed and licensed.

You must be logged on to the Avid Motion Graphics server as Administrator.

The AMG Journalist Server installation process includes the following tasks:

• “Installing Avid Motion Graphics Journalist Server Software” on page 6

• “Licensing AMG NRCS Clients and AMG Clips” on page 12

• “Configuring the Avid Motion Graphics Journalist Server” on page 15

• “Starting the AMG Journalist Server Applications” on page 18

Installing Avid Motion Graphics Journalist Server Software

This section contains the basic procedures that must be followed to install the AMG Journalist 
Server.

Prior to starting the AMG Journalist installation, confirm the Win2008 R2 64 bit installation, and 
then install both the vcredist_x64 and vcredist_86 installers.

To confirm the Win2008 R2 64 bit installation:

1. Open a command prompt by selecting Start > Run. 

2. Type cmd.

3. Press Enter.

4. Type ver

5. Press Enter.

The version of the server should be 6.1.7601. 
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6. Before continuing with the AMG Journalist installation, enable Windows Media Player on 
the AMG Server as follows:

a. Launch Server Manager. 

n Windows Media Player must be enabled before proceeding. This is part of the Desktop 
Experience feature for Windows Server 2008.

b. Click on Features > Add Feature > Desktop Experience.

c. Accept Ink and Handwriting Service as well. 

d. Click Add Required Features, and click Next.

e. Click Install.

f. Reboot your AMG server.

To Install the Avid Motion Graphics Journalist Server:

1. Navigate to the installer for AMG Journalist Server, and double-click 
AMG_Journalist_Server_setup.exe.

The Avid Motion Graphics Journalist Installer splash screen opens:

2. Select the option to install Microsoft Visual C++ 2008 Redistributable.
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3. Select the option to install the Avid Motion Graphics Journalist Server.

The License Agreement dialog box opens.

n This will share the AMGNews folder and configure the X: drive. It also installs the AMG Drive 
Monitor.

4. Accept the terms of the license agreement, and click Next.

The Destination folder dialog box opens.
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5. Click Next to accept the path where the AMG Journalist Server will install the application 
files. 

For more information on this setting, please consult with your Customer Success 
Representative.

The AMG Share dialog box opens:

6. Click Next to accept the default AMG Share and Drive Letter (X:), where the AMG 
Journalist Server will install the application files.

For more information on this setting, please consult with your Customer Success 
Representative.
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The Ready to Install the Program dialog box opens:

7. Click Install to complete the AMG Journalist Server installation.

The screen refreshes with more options.

8. On the Avid Motion Graphics Journalist splash screen, click the option PostgreSQL 8.4.4.

The Avid Motion Graphics Journalist splash screen appears as follows:
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9. Click the first option Install PostgreSQL 8.4.4.

It will install the next three options automatically.

- PostgreSQL Service

- PostgreSQL Windows User

- PostgreSQL Windows Password

10. Click the option to install PostgreSQLSubnet Selection.

The AMG PostgreSQL Database Access Configuration dialog box opens.

11. Select the Save pg_hba.conf option at the bottom left of the screen.

12. Press Enter to close the Command window.

13. Select the Back to Main Screen option the return to the AMG Journalist Installer Server 
Main menu.

14. Select Create AMG Databases.

15. Select Click here to Install AMG Journalist Databases.

Wait until the AMG Journalist databases are installed. When it is done, the message “AMG 
Database Creation Complete” appears.

16. Select Return to return to the AMG Journalist Server Installer main menu.
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17. Click the option to install AMG ODBC.

The AMGNews Journalist Server J-SERVER dialog box opens.

18. Select Yes on the pop-up menu.

19. Select Exit to exit the AMG Journalist Installer and return to the Windows desktop.

Licensing AMG NRCS Clients and AMG Clips

The Avid Motion Graphics Journalist Server requires the AMG NRCS license.

The Avid Motion Graphics Journalist System ID label, as shown in the following illustration, is 
used as the System ID number to activate the Avid Motion Graphics NRCS Clients, and AMG 
Clips options. 
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n The AMG Preview Renderer requires a separate license for it to be activated on the computer 
where the Preview Renderer software is installed.

The Avid Motion Graphics NRCS Client and AMG Clips activation is performed on the AMG 
Journalist Server.

To activate the license for Avid Motion Graphics NRCS Clients:

1. Locate your System ID and Activation ID card(s) included with your new hardware (in a 
separate box).
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2. Open the Avid License Control tool, click Start > Programs > Avid > Utilities > Avid 
License Control.

The Avid License Control dialog box opens.

3. Click the Activate button to activate the Avid Motion Graphics NRCS license.

n The license is most easily added with an internet connection, so that the computer can connect to 
the Avid license server and verify the license. For more information, see “Software Licensing” 
on page 25.

n After your Avid software is activated, the License Profile tab displays your System ID, Activation 
ID, and Device ID.

4. In the “How would you like to proceed?” section, select the I am connected to the Internet 
and will use this computer option, and then click Continue.

n If you select “I am not connected to the Internet and will be using another computer that is 
connected to the Internet” continue with “License Activation Without an Internet Connection” 
on page 29.

5. Enter your system identification number in the System ID text box.

6. Enter your activation identification number in the Activation ID text box.
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7. Click the Activate button.

The Activation tool confirms your system information. When the activation is complete, a 
message informs you that your software has been successfully activated and the “Activate” 
button changes to a “Deactivate” button.

8. Back up your license profile information, and save it somewhere that you can access it.

Configuring the Avid Motion Graphics Journalist Server

After installing the server software, you must configure the Avid Motion Graphics Journalist 
Server.

To configure the Avid Motion Graphics Journalist Server:

1. On the Avid Motion Graphics Journalist Server, navigate to: 
C:\AMGNews\bins\cfg\AMGConf.ini.

2. In the GENERAL section:

t Set VIDEO FRAMES to NTSC or PAL.

t Set the SLUG FORMAT to <tpl>.

n All values in the AMG.ini files must be surrounded by quotes. When editing values, remember to 
keep the quotes in tact.

3. In the MOS DEVICE section:

t Confirm the NAME is set to AMGNews. 

n This assumes the desired MOS ID is AMGNews.

t In the CHANNELS field, enter the channels names that you intend to use in the system. 
Each name must be separated by a comma and space (e.g., 1, 2, 3, for graphics 
channels).

n iNEWS Command will need to use the same channel names, so it's a good idea to write down or 
remember the channel names used here.

4. In the PREVIEW SNAPS section:

t Set the IP to the specific address for the local AMG Journalist Server (do not use 
127.0.0.1, or a host name).

n This IP is for the AMG News Preview Server application, which runs on the AMG Journalist 
Server. The IP does not point to the AMG Preview Renderer itself - that IP is set in a different .ini 
file, and explained in Step 11.
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5. In the GATEWAY section:

t Set the IP to the specific address for the local AMG Journalist Server.

n Do not use 127.0.0.1, or a host name)

t For iNEWS, leave the NCS and MOS ports at their current values (e.g., NCS UPPER 
PORT Should be 10441 for iNEWS, and NCS LOWER PORT should be 10440 for 
iNEWS).

t For ENPS, change the NCS UPPER PORT to 10541, and the NCS LOWER PORT to 
10540.

6. In the MANAGER section:

t Set the IP to the specific address for the local AMG Server. 

n Do not use 127.0.0.1, or a host name.

t For iNEWS, confirm that IS NCS is set to YES.

t For ENPS, change IS NCS to NO.

7. In the CONTROL section (where NAME = CTRL1):

t For Command, comment out this entire section with a ; at the beginning of each line.

8. In the CONTROL section (where NAME = COMMAND1):

t Set the IP to the specific address for the Avid Motion Graphics computer.

t If you have a second device, you need to add a new section with the name 
COMMAND2, for the second device. This is done by doing the following:

- Copy the [CONTROL] section, and paste it just below the original CONTROL section.

- Change the NAME field to COMMAND2.

- Change the IP field to that of the second AMG Playout chassis.

9. In the RENDER sections (There are two.):

t For Command, comment out this entire section with a ; at the beginning of each line.
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10. In the NCS section:

t In the NAME field, enter the NRCS server name. 

n This is the iNEWS system name which you can get by typing status on the iNEWS console.

t For iNEWS, leave the IP as is at 127.0.0.1.

t For ENPS, enter the IP for the ENPS server. For the buddy server, add the following:

"BACKUP NAME" = "ENPS BUDDY SERVER NAME"

"BACKUP IP" = "ENPS BUDDY SERVER IP"

t If you want to see more than the first 2 replaceable fields in the Command playlist, 
change the ABSTRACT FMT field from <2values> to the desired number.

t For ENPS, confirm that the <ch> variable has been added to the beginning of the 
ABSTRACT FMT line. 

For example: “ABSTRACT FORMAT” = “<ch>:<tpl>:<2values>”

11. Select File > Save, and then close the AMGConf.ini file.

12. On the AMG Journalist Server, go to C:\AMGNews\bins\conf\Previewunits.ini.

There are 2 UNITs sections. In each UNIT field, the default UNIT1 and UNIT2 are for 
Render Engines A, and B on the Preview Renderer machine.

In both IP fields, enter the IP address for where the AMG Preview Renderer will be running.

13. In the [UNIT] section, for UNIT1, and UNIT2, set the IP address to the IP address of the 
Preview Renderer machine.

If any additional Preview Renderers are added, you need to create two additional UNIT 
sections. This is done by doing the following:

- Copy the [UNIT] section, and paste it just below the original UNIT section.

- Change the UNIT1 field to UNIT3.

- Change the UNIT2 field to UNIT4.

- Change the IP field to that of the second Preview Renderer.

14. Select File > Save, and then close the Previewunits.ini file.

15. Double-click on My Computer and navigate to the X: drive.

16. Open TPL_example, and copy and paste the contents to the TPL folder on the X: drive.

17. Launch the AMG Monitor application. For more information, see “Starting the AMG 
Journalist Server Applications” on page 18.
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Starting the AMG Journalist Server Applications

After the AMG Journalist server configuration is complete, you can start the AMG Journalist 
Server applications.

To start the AMG Journalist Server applications:

1. Turn on the Avid Motion Graphics Journalist server.

2. Double-click the AMG Application Monitor shortcut on the desktop, and enable and start 
the Avid Motion Graphics Journalist Server applications.

- AMG Gateway: manages communication between NRCS, database, and Command.

- AMG News Licenser: gives out Avid Motion Graphics Journalist client license seats.

- AMG Preview Renderer: manages Avid Motion Graphics Preview Renderer requests

3. Select AMG Gateway, and click Enable Application.

4. Select AMG News Licenser, and click Enable Application.

5. Select AMG News Preview Server, and click Enable Application.

6. The Avid Motion Graphics Journalist Server applications should start automatically.

Installing AMG Journalist Client Software

The following steps describe how to install the Avid Motion Graphics Journalist Client for 
integration with Command, and iNEWS or ENPS. 

The network drive should be connected before starting this setup. Make sure the network drive is 
mapas follows: network drive \\***.***.***.***\AMGNews, where * is the AMGJournalist 
Server IP.

n If you configure AMG Journalist for iNEWS, you can use it as a plug-in to Interplay Central, but 
you must first enable your browser to accept MOS plugins.

To install the AMG Journalist Client plug-in:

1. Navigate to the network drive (via UNC path - \\servername\AMGNews).

2. Open the install folder.

3. Double-click the Avid_Motion_Graphics_Journalist_setup.exe to run the executable.

4. In the AMG Journalist Applications window, click the AMG NRCS Client to install it.

5. Select Microsoft Visual C++ Redistributable to install it.

6. Select AMG Drive Monitor to install it. Make sure the IP address for the AMG Journalist 
server is populated. Follow the prompts (Install, Next, Finish) to complete the installation.
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7. Select AMG ODBC to install it. 

n A database password is not necessary, and should not be entered.

8. Select AMG NRCS to install, and click Finish to complete the installation.

9. Select Exit to close the installer.

You can now test the AMG Journalist Client. 

10. (Optional) If you are using AMG Journalist Client (a MOS plugin) with iNEWS and 
Interplay Central, you need to configure your web browser to accept MOS plugins.

t If you are using Chrome as your browser, you must install the Chrome Extension for 
Interplay Central MOS plug-in. For more information, see Appendix F of the Interplay 
Central Services Installation and Configuration Guide.

t If you are using Internet Explorer as your browser, you must enable Interplay Central 
MOS plug-ins in Internet Explorer. For more information, see Appendix G of the 
Interplay Central Services Installation and Configuration Guide.

Setting Up the AMG Preview Renderer

This section contains the following topics:

• “Installing the AMG Preview Renderer” on page 20

• “Licensing the AMG News Preview Renderer and AMG Clips” on page 22

• “Starting the Avid Motion Graphics Preview Renderers” on page 25

• “Creating Project Shortcuts on the AMG Preview Renderer” on page 25
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Installing the AMG Preview Renderer

The following describes installing the Avid Motion Graphics Preview Renderer on a dedicated 
computer.

For baseline computer requirements, see an Avid Sales associate.

Before starting this procedure, the X-drive should be connected. Make sure the network drive is 
mapped as follows: \\***.***.***.***\AMGNews, where * is AMG Journalist server IP address.

To install the Avid Motion Graphics Preview Renderer:

1. Navigate to the X-drive (via UNC path - \\servername\AMGNews).

2. Open the Install folder.

3. Double-click the Avid_Motion_Graphics_Journalist_setup.exe.

4. Select Yes. 

The User Account Control dialog box opens.

n The installer may detect some items already installed. If the menu item as a green check next to 
it, it is already installed and you can move on to the next step. In the example above, the first four 
items have already been installed.

5. In the AMG Journalist Applications window, click Avid Motion Graphics News Preview 
Renderer to install it.
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6. Click Microsoft Visual C++ 2008 Re-distributable to install it.

7. Click the Avid Motion Graphics Drive Monitor to install it. 

8. You will need to enter the IP address for the Avid Motion Graphics Journalist server.

The Host name or IP address for the Avid Motion Graphics Journalist Server will appear in 
the AMG Drive Monitor dialog box. Follow the prompts, clicking Next, to proceed. Then, 
click Install. When finished installing, click Finish. 

9. Click Avid Motion Graphics ODBC to install it. Follow the prompts, clicking Install, and 
then click Next to proceed.

n A database password is not necessary, and should not be entered.

10. Click Avid License Control to install it.

11. Click Avid Motion Graphics News Preview Renderer to install it.

12. Click Avid Motion Graphics Font Package to install it.

n If you planing to use Avid Deko compositions in AMG, you need to install Deko Player 6.3.0 and 
Deko Chart Designer 1.1.0. If you are not upgrading from Avid Deko you can skip these to 
installs.

13. Click Exit to close the installer licensing.

14. Open the Avid License Control tool.

15. Add the Preview Renderer licenses (Preview and Clips). If you do not have a Preview 
Renderer license, contact your sales representative to obtain a license.

n The license is most easily added with an internet connection, so that the computer can connect to 
the Avid license server and verify the license. 
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Licensing the AMG News Preview Renderer and AMG Clips

Once you have installed the AMG Preview Renderer on a dedicated computer, you need to 
license the AMG News Preview Renderer, and the AMG Clips option should be activated on 
AMG chassis.

Before you begin, you should have the following two Activation labels:

• AMG News Preview Renderer Activation label

• AMG Clips Activation label

You will also need to the System ID from the AMG Journalist System ID label. The Avid Motion 
Graphics Journalist System ID label, as shown in the following illustration, is used as the System 
ID number to activate the AMG News Preview Renderer and AMG Clips products.

The activation is performed on the computer that you installed the AMG Preview Renderer on.

n The license is most easily added with an internet connection, so that the computer can connect to 
the Avid license server and verify the license. For more information, see “Software Licensing” 
on page 25.
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To activate the license for AMG News Preview Renderer and AMG Clips:

1. Locate your System ID and Activation ID card(s) included with your new hardware (in a 
separate box).

2. Open the Avid License Control tool, click Start > Programs > Avid > Utilities > Avid 
License Control.

The Avid License Control tool opens.

n After your Avid software is activated, the License Profile tab displays your System ID, Activation 
ID, and Device ID.

3. Click the Activate button for AMG News Preview Renderer license.
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4. In the “How would you like to proceed?” section, select the I am connected to the Internet 
and will use this computer option, and then click Continue.

n If you select “I am not connected to the Internet and will be using another computer that is 
connected to the Internet” continue with “License Activation Without an Internet Connection” 
on page 29.

5. Enter your system identification number in the System ID text box.
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6. Enter your activation identification number in the Activation ID text box.

7. Click the Activate button.

The Activation tool confirms your system information. When the activation is complete, a 
message informs you that your software has been successfully activated and the Activate 
button changes to a Deactivate button.

8. Repeat Steps 3-7 to activate the AMG Clips license on the AMG chassis.

9. Back up your license profile information, and save it somewhere that you can access it.

Starting the Avid Motion Graphics Preview Renderers

After starting Avid Motion Graphics and the Avid Motion Graphics Journalist Server, you must 
start the Avid Motion Graphics Preview Renderers A and B.

To start the Avid Motion Graphics Preview Renderers A & B

1. On the Avid Motion Graphics Preview Renderer computer, select Start > AMGNews 
Preview Renderer A.

2. Select File > Project > Open All, and navigate to the X:\TPL folder to open the project.

3. On the Avid Motion Graphics Preview Renderer computer, select Start > AMGNews 
Preview Renderer B.

4. Select File > Project > Open All, and navigate to the X:\TPL folder to open the project.

Creating Project Shortcuts on the AMG Preview Renderer

After the on-air project is finalized, you can create Start Menu shortcut to open the project on the 
AMG Preview Renderer.

To create project shortcuts on the AMG Preview Renderer:

1. Navigate to X:\TPL\basic.ldr.

2. Create a shortcut to that file on the desktop.

3. Double-click the file to open the project in Preview Renderer A.

4. With the project open, double-click the shortcut again, to open the project in Preview 
Renderer B.

5. Drag the Preview Renderer A shortcut to the Start menu.

Now you can click Start, point to the Preview Renderer A, and select the project to open 
both Preview Renderers.
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Setting Up the AMG Advanced Device Manager

This section contains information on how to install, license, and configure the AMG Advanced 
Device Manager. 

This section contains the following topics:

• “Installing the AMG Advanced Device Manager” on page 26

• “Licensing the AMG Advanced Device Manager” on page 27

• “Configuring the AMG Advanced Device Manager” on page 28

Installing the AMG Advanced Device Manager

This topic contains information on how to install and configure Avid Motion Graphics Device 
service on each Avid Motion Graphics playout chassis.

To install the AMG Advanced Device Manager:

1. Navigate to the Avid Motion Graphics Journalist Server installation path (via UNC path - 
\\servername\AMGNews).

2. Open the Install folder.

3. Double-click the Avid_Motion_Graphics_Journalist_setup.exe.

4. In the AMG Journalist Applications window, click AMG Playout.

5. (Option) If not already installed, click Microsoft Visual C++ Redistributable to install.

6. (Option) If not already installed, click Avid Motion Graphics Drive Monitor to install. You 
will need to enter the IP address for the Avid Motion Graphics Journalist server 

7. Click Avid Motion Graphics ODBC to install. A database password is not necessary, and 
should not be entered.

8. Click the AMG Advanced Device Manager option to install the AMG Advanced Device 
Manager onto the AMG Playout server.

n Wait for all of the components to install before continuing. After each component successfully 
installs, a green circle, containing a white check mark, replaces all of the red circles, containing 
white Xs. If a component is already installed, it is detected and the green circle with the check 
mark appears immediately.

n Avid License Control should already be installed, and have a green check mark next to it.
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9. Open the Avid License Control tool and confirm that you have the respective AMG licenses 
added (green check mark). If not done, add the AMG ADM license. For more information, 
see 

n The license is most easily added with an internet connection, so that the computer can connect to 
the Avid license server and verify the license. 

Licensing the AMG Advanced Device Manager

This topic contains information on how to license the AMG Advanced Device Manager.

If you have not already done so, open Avid license control under Start > All Programs > Avid > 
Utilities and add the AMG NRCS license. That is the only license component that is needed on 
the AMG Journalist Server. 

n If you do not have an NRCS license, contact your sales representative to obtain a license. 

n The license is most easily added with an internet connection, so that the machine can connect to 
the Avid license server and verify the license.

To license the AMG Advanced Device Manager:

1. Open Avid License Control by navigating to Start > All Programs > Avid > Utilities. 

2. Locate Avid Motion Graphics, ADM in product list and activate it by pressing the Activate 
button.

3. In the “How would you like to proceed?” section, select the I am connected to the Internet 
and will use this computer option, and then click Continue.
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n If you select “I am not connected to the Internet and will be using another computer that is 
connected to the Internet” continue with “License Activation Without an Internet Connection” 
on page 29.

4. Enter your system identification number in the System ID text box.

5. Enter your activation identification number in the Activation ID text box.

6. Click the Activate button.

The Activation tool confirms your system information. When the activation is complete, a 
message informs you that your software has been successfully activated and the Activate 
button changes to a Deactivate button.

Configuring the AMG Advanced Device Manager

Once you have installed and licensed the AMG Advanced Device Manager on your AMG 
Playout chassis, you must configure it.

Configuring the AMG Advanced Device Manager:

1. From the Start menu select All Programs > Avid > Advanced Device Manager 
Configuration Tool. The Advanced Device Manager Configuration dialog box opens. 

There are two protocol selection tabs available. The Primary Protocol Selection is used to 
configure AMG Channel A with Avid Command. 
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n If the AMG Playout chassis is optioned for Dual Channel, and you want to control the second 
channel using a different protocol, this can be accomplished by selecting the Secondary Protocol 
Selection tab. Select AMG News Output Channel B.

2. In the Protocol In field (for use with Command), select GAP (Graphics Automation 
Protocol).

3. In the ADM PORT field, set the value to 5200.

4. In the AMG Config.ini Location field, make sure it points to X:\bins\cfg\AMGConf.ini.

5. In the MOS DEVICE field, type AMGNews.

6. In the Protocol out field, select AMG.
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7. In the Receive PORT field, select 5555.

8. In the AUTO LOAD field, select True.

9. In the Pattern Match field, type X:\RSC\IMG. Then, in the >> field, type C:\TMP.

10. In the TPL Folder field, make sure it points to X:\TPL.

11. In the METATPL Folder field, make sure it points to X:\METATPL.

12. In the TPL EXTENSION field, scn.

13. , To set up the first output channel (A), do the following: 

a. In the AMG Output Channel section, select A to set up the first output channel.

b. In the PGM-A IP or Name field, type the IP address of the local AMG chassis. You can 
use the local host name, as well.

c. In the PGM-A PORT field, select 5124.

d. In the PVW-A IP or Name field, type the IP address of the local AMG chassis. You can 
use the local host name, as well.

e. In the PVW-A PORT field, select 5124.

14. (Option) If the chassis is a single channel AMG Playout chassis, go to the Step 16: 

15. To set up the second Output channel (B), do the following: 

a. Enable the B Channel by selecting Yes in the Enable B Channel? menu.

b. In the AMG Output Channel section, select B to set up the second output channel.

c. In the PGM-B IP or Name field, type the IP address of the local AMG chassis. You can 
use the local host name, as well.

d. In the PGM-B PORT field, select 6124.

e. In the PVW-B IP or Name field, type the IP address of the local AMG chassis. You can 
use the local host name, as well.

f. In the PVW-B PORT field, select 6124.

16. Click the Save Configuration button and close the Advanced Device Manager 
Configuration Tool.
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Installing the Avid Service Framework
If you are running iNEWS Command, the Avid Motion Graphics chassis needs at least the core 
components of Service Framework installed, so that it is able to connect to a computer running 
the Avid Lookup service. 

To install the Avid Service Framework:

1. Insert the Command installation CD (or access the install program from the network).

The autorun installation program starts and displays the following screen.

n The Command Documentation button will open a window displaying the contents of the Doc 
folder on the Command installation CD in which product documentation is provided in PDF 
format.

If the autorun does not begin, manually navigate to and run the ServiceFrameworkSetup.exe 
install program.
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2. Click the Avid Service Framework button. 

n Other dialog boxes could appear depending on whether older versions of Service Framework are 
found, particularly if upgrading existing software. If one appears, read it carefully and reply 
accordingly with regard to upgrades, etc.

A splash graphic will appear briefly as the installer prepares the InstallShield Wizard. Then 
the Welcome dialog box appears.
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3. Click Next.

The Destination Folder dialog box opens.

4. Set the location to which Avid Service Framework will be installed and click Next.

The Workgroup Name dialog box opens.
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5. Type the name of the Command workgroup in the field.

c If you are updating the Service Framework software, the installer remembers the last 
installed value. If the workgroup name was changed after the install, the installer will not 
be aware of the change.

6. Click Next. 

The Options dialog box opens.
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7. Select the option: Avid Service Framework Client and click Next.

The Custom Setup dialog box opens.

By default, the Time Synchronization service is selected to be installed; however, this 
service should only be installed if you do not already use something to synchronize your PC 
clocks. If you use NTP or some other method for time synchronization, do not install this 
service. For more information about the services in this dialog box, see the tables in 
“Installing the Avid Service Framework” on page 31.

8. Click Next and follow the installation instructions to complete the installation.

n You might be required to restart your system to complete the installation.

After installation, verify that the services are running on each computer where Service 
Framework services were installed.
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Setting Up the AMG Device Service

This section contains information on how to install and configure the AMG Device Service. 

This section contains the following topics:

• “Installing Avid Motion Graphics Device Service” on page 36

• “Configuring the AMG Device Service” on page 39

Installing Avid Motion Graphics Device Service

This section provides the standard procedure for installing the Avid Motion Graphics Device 
Service on each Avid Motion Graphics playout chassis.

To install the Avid Motion Graphics Device Service on the AMG playout chassis:

1. On the AMG playout chassis, install iNEWS Command and select the AMG Device Service 
from the install menu.

When the autorun program starts, select the Avid iNEWS Command button. The 
InstallShield Wizard starts and displays the Welcome screen.

2. Click Next.

The License Agreement appears.
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3. Read the License Agreement, accept the terms, and click Next.

If you do not accept the terms, the installation program will not continue.

n You can print the terms if you want to read them later or keep a copy for your records.

The Destination Folder dialog box opens.
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4. Do one of the following:

t Click Change to designate an install directory, and then click Next.

t Accept the default location by clicking Next.

The Options dialog box opens.

5. Select Avid Motion Graphics, and click Next.

The Custom Setup dialog box appears with the default services selected for installation of 
client software. However, for CII integration, you must modify the selections to customize 
your installation. 

If you select Avid Motion Graphics, no more services would be selected. Only AMG device 
service
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6. Click Next to continue.

7. When the Ready to Install the Program dialog box appears, click Install.

8. When the installation is complete, click Finish.

You are now ready to install the appropriate plug-in or the Graphic Inventory Editor (GIE), if 
necessary.

Configuring the AMG Device Service

Once you have installed the AMG Device Service on each Avid Motion Graphics playout 
chassis, you must next configure it. 

To configure the AMG Device Service:

1. Select Start > All Programs > Avid Service Framework.

2. Open the Avid Service Configuration application.

3. Navigate to the local machine, open the drop down menu, and select the Avid Motion 
Graphics Device Service.

4. Enter a Device name (in lowercase), such as “amg1”, and set the channel count to 1 for 
single-channel, or 2 for dual-channel playout chassis.

5. Click the AMG Device Service Settings tab.
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6. In the ADM IP field, type the local machine’s specific IP address.

7. In the NET CONNECT AS, type the computer name\user name for the AMG Journalist 
Server, so that the device service connects to the AMG Journalist Server with the right 
credentials. 

n If the Journalist Server uses a local log in, enter the local computer name and user name, such 
as AMGJourn\Admin. A domain login also works here.

8. In the NET PASSWORD field, type the password for that user name (if there is one). 
Otherwise, leave it blank.

9. In the NET SHARED RESOURCE field, type the AMG Journalist computer name and 
share name. For instance, \\AMGJourn\AMGNews.

n Make sure the case matches.

10. Confirm that the SYSTEM MOS ID is correct. It should be the same (including the case) as 
was configured in the AMGConf.ini and the ADM Configuration.

n After changing any value, select a different field before clicking Apply, so that the last change is 
kept. Or press Enter.

11. After the configuration is complete, click the Apply button.

The service restarts automatically.

12. Close the window. 

Confirming Functionality

Once you have created a project to test with, you can confirm functionality by doing the 
following:

• Starting the Avid Motion Graphics Journalist Server

• Starting Avid Motion Graphics

• Starting the Avid Motion Graphics Preview Renderers

• Testing the AMG Journalist Client

• Testing Command Inventory, Playout, and Editing
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Starting the Avid Motion Graphics Journalist Server

Starting the Avid Motion Graphics Journalist Server is the second task in confirming 
functionality.

To start the Avid Motion Graphics Journalist Server:

1. Turn on the Avid Motion Graphics Journalist Server.

2. Click the Avid Motion Graphics Monitor shortcut to start the following server applications:

- Avid Motion Graphics Application Monitor

- AMG Gateway

- AMG News Licenser

- AMG News Preview Server

Starting Avid Motion Graphics

Starting the Avid Motion Graphics server is the first task in confirming functionality.

To start Avid Motion Graphics:

1. Turn on the Avid Motion Graphics computer.

2. Start the Avid Motion Graphics application.

3. Click File, > Project > Open and navigate to the X:\TPL folder to open the project.

4. Click the Playout button. This step is required for any playout operation.

5. Run the Advanced Device Manager. This initiates the Open All command. You are now 
ready to play items in Command. If you have to close and open the UI for any reason, do the 
following:

- Open the Avid Motion Graphics application from your shortcut.

- In the Avid Motion Graphics user interface, switch to Playout mode.

- In the open Advanced Device Manager, click the Connect button, which initiates the 
Open All.
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Starting the Avid Motion Graphics Preview Renderers

After starting Avid Motion Graphics and the Avid Motion Graphics Journalist Server, you must 
start the Avid Motion Graphics Preview Renderers.

To start the Avid Motion Graphics Preview Renderers A & B”

1. On the Avid Motion Graphics preview Renderer computer, click Start > AMGNews 
Preview Renderer A.

2. Select File > Project > Open All, and navigate to the X:\TPL folder to open the project.

3. On the Avid Motion Graphics preview Renderer computer, click Start > AMGNews 
Preview Renderer B.

4. Select File > Project > Open All, and navigate to the X:\TPL folder to open the project.

Testing the AMG Journalist Client

After starting the Avid Motion Graphics Preview Renderers, you can test the functionality of the 
Avid Motion Graphics Journalist client.

To test the AMG Journalist client:

1. Open the AMG Journalist client.

If you are using the iNEWS NRCS client to open the AMG Journalist plug-in, go to Tools > 
Plugins > AMG Journalist.

The Plugin window will open and become a part of your workspace. 

To check functionality, compare the TPL folder content with what you see in the plugin. The 
AMG Journalist plug-in should open the TPL folder and scan for AMG projects. So you 
should be able to see any project compositions.

2. Double-click an item to open it in the template editor.

3. Add replacement data and click Save.

The new item should appear in the Graphic Database area list with a unique ID for the item.

4. Open the new item and edit the first replaceable field.

5. Click Save and confirm that the data has updated.

6. Open the created item and click the Preview button. 

Preview will not be enabled if it has not been installed.

7. Confirm that the correct replacement data appears.

8. Open the created item and click the Movie button.

Movie will not be enabled if it has not been installed.
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9. Confirm that the item appears with motions and correct replacement data.

10. Create several more items and drag them into the rundown.

11. Create a hand-entered item.

12. Designate one of the items as a library graphic and drag into a playlist.

13. MON Load the show, and confirm that all graphics appear in the Command playlist.

Testing Command Inventory, Playout, and Editing

After confirming functionality of the Avid Motion Graphics Journalist Client, you must test the 
Command inventory, playout, and editing functionality.

To test Command inventory, playout, and editing:

1. In the Inventory Panel, confirm that you can see the templates from the your project, and the 
library graphic you created.

2. Confirm that thumbnails appear in the playlist.

3. Lock channel group by doing the following:

a. Confirm that the replacement fields update (if not already updated).

b. Cue and play items – confirm on output.

4. Open item in media viewer and change replacement data by doing the following:

a. Confirm that data is updated in the playlist.

b. Confirm that the thumbnail updates.

c. Open the item in the Avid Motion Graphics Journalist client, and confirm that the 
replacement data has also changed here.

5. Play the cued item. Confirm that it appears on the output, and that the next item cues as 
expected. 

6. Eject the item from the program channel.
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Example of AMGConf.ini File for iNEWS Command

This topic contains an example of the AMGConf.ini configured for iNEWS Command.

; This a sample base file for AMG, iNews, and iNews Command.

;

[GENERAL]

"ENCODING"= "UTF8";UTF8 or ASCII

"VIDEO FRAMES"= "NTSC";PAL or NTSC, it is used to calculate the length of 
the graphics

"LOG FILES"= "3";Max num log files

"TEXT DB"= "P_TEXTS";Database that can be used to fill templates

"AUTO SLUG"= "MIXED";TRUE, FALSE or MIXED

"SLUG FMT"= "<tpl>:<id>";Format used to generate auto slugs

"AUTO SNAPS"= "FALSE";TRUE to enable auto snaps feature

"OBJ READY"     = "TRUE";TRUE if graphics must be created "Ready for Onair" 
by default

"WAIT ACK"= "FALSE";Wait for ACKS

"FORMAT"= "jpg";Snapshot format

"TPL EXTENSION"= "scn"

[PREVIEW SNAPS]

"NAME"= "SNAPS"

"IP"= "xxx.xxx.xxx.xxx"   ;AMG PreviewServer Application IP address

"PORT"= "6125";Port where to send the requests

"ACK PORT"= "5125";Port where the plug-in will get the answer
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"SNAPS PATH"= "X:\preview";net path where to find the snap files

"OBJS PATH"= "X:\preview\objs"  ;net path where to find the graphics images

"VIEW X-RES"= "400";Resolution used by the plug-in to show the

"VIEW Y-RES"= "225";generated snaps

;"EXPORT FMT"= "<date>_<time>_<user>" ;patern to generate exported movie 
names

;"EXPORT PATH"= "";SNAPS PATH will be used if this is not defined

;"EXPORT MASTER" = "USER";USER or SERVER. Who copies the final file to 
EXPORT_PATH

[GATEWAY]

"NAME" = "GW1"   ;This name will be used by other components

"IP" = "xxx.xxx.xxx.xxx";AMG Gateway Application IP address (journalist 
server) 

"NCS UPPER PORT" = "10441"   ;MOS Protocol Ports 

"NCS LOWER PORT" = "10440"

"MOS UPPER PORT" = "10541"

"MOS LOWER PORT" = "10540"

[MOS DEVICE]   ;THIS DEVICE IS FOR COMMAND

"NAME"= "CMD"            ;Render Unit name (this needs to match MOSID in 
system.map file)

"GATEWAY"= "GW1"   ;Gateway that creates content for this Render Unit

"TPL FOLDER"= "X:\Tpl"   ;Net path where the templates can be found

"RSC FOLDER"= "X:\RSC"   ;Net path where resources used to create graphics 
can be found
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"OBJ FOLDER"= "P_RENDER2"

"DB TYPE"= "ODBC"   ;System used to manage the graphics. FILE (deprecated) 
or ODBC. 

"VERSION"= "2.6"   ;Protocol Version. "2.6" or "2.8" for MOS, "CA" for 
ControlAir

"CHANNELS"= "1,2"

[CONTROL]

"NAME"= "COMMAND1"   ;Name used by the Render Unit to reference this 
Controller

"MOS DEVICE"= "CMD"      ;Name used by the Gateway where the Controller 
sends commands

"IP"= "xxx.xxx.xxx.xxx" ;IP where the Controller is running - (the AMG 
Chassis)

"PORT"= "8888"

"ALL UPDATES"= "TRUE"

[MANAGER]   ;License Manager settings.

"NAME"= "MAIN"

"IP"= "xxx.xxx.xxx.xxx" ;AMG News Licenser Application IP address

"PORT"= "5140"

"IS NCS"= "YES"   ;If using iNEWS, it's YES. If using ENPS, NO.  Refers to 
whether 

   ;or not the License server will act as an NCS server.

[NCS]   ;THIS NCS SECTION IS FOR COMMAND

"NAME"= "NRCS4"   ;iNEWS server name, ENPS server name or RCG Manager Name
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"IP"= "127.0.0.1"       ;localhost

"AUTO ABSTRACT" = "TRUE"      ;Generate the abstract field for iNews and 
ENPS

"ABSTRACT FMT"= "<tpl>:<2values>" ;Format used to generate the auto 
abstract

"DB TYPE"= "ODBC"      ;it MUST be "ODBC". Only used in stand-alone mode

"DB PATH"= "P_NCS"   ;ODBC source name.

"VENDOR" = "MOS"   ;Speciall behaviour for some vendors [MOS, VSN]

;[DICTIONARY]

;"NAME"= "MyDICT"

;"REPLACE"= "X:\RSC >> D:\Playout\Clips"



2 Installing and Configuring Avid Motion 
Graphics News Control

The following provides instructions for installing and configuring Avid Motion Graphics News 
Control (AMG News Control) software and related applications.

Avid Motion Graphics Servers must have already been installed and licensed before you can 
install Avid Motion Graphics News Control.

To use AMG News Contol you will also need to install, license and configure an iNEWS MOS 
Gateway. Once configured, the iNEWS MOS Gateway communicates to AMG News Control via 
the AMG MOS Gateway which is automatically installed when you install the AMG Journalist 
Server applications.

Before you begin, make sure you have licenses for the following AMG News components:

• NRCS

• AMG News Preview Renderer (2)

• AMG Clips (2)

• AMG News Control

The following topics is included:

• AMG News Control Installation Tasks

• Example of AMGConf.ini File for AMG News Control

After setting up and configuring settings of the operating system for your Avid Motion Graphics 
system you can install the Avid Motion Graphics News Control software and related 
applications.

n The Avid Motion Graphics software is available on the Avid Download Center 
(www.avid.com/support/downloadcenter).



AMG News Control Installation Tasks

49

AMG News Control Installation Tasks

When you do not have iNEWS Command, but use scripts and rundowns in a MOS environment 
you can use Avid Motion Graphics News Control. This section contains procedures on how to 
install and configure the Avid Motion Graphics News Control for use in a MOS workflow 
environment. 

Before installing AMG News Control, the Avid Motion Graphics servers must have already been 
installed and licensed.

You must be logged on to the Avid Motion Graphics server as Administrator.

n If you are not using iNEWS Command, you will need AMG MOS Gateway and Avid MOS 
Gateway.

The AMG Journalist Server installation process includes the following tasks:

• “Installing AMG Journalist Server Software” on page 50

• “Configuring the AMG Journalist Server with AMG News Control” on page 50

• “Licensing AMG News Control” on page 52

• “Understanding the X: Drive Network Share” on page 53

• “Installing Avid Motion Graphics Journalist Client” on page 54

• “Installing the AMG Preview Renderer” on page 54

• “Creating a Project Shortcut” on page 56

• “Configuring Avid MOS Gateway, AMG News Control and iNEWS” on page 57

• “Configuring ENPS to Host the AMG Journalist Client” on page 58

• “Confirming Avid Motion Graphics Journalist Functionality” on page 59
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Installing AMG Journalist Server Software

When installing Avid Motion Graphics News Control for integration with AMG Journalist 
Server and either the Avid iNEWS News Room Computer System (NRCS) or ENPS, you must 
first make sure AMG Journalist Server is installed. This might already be done. 

If AMG Journalist Server software is:

• Not installed, go to the topic “Installing Avid Motion Graphics Journalist Server Software” 
on page 6. Once it is installed, you need to configure it for AMG News Control. For mor e 
information, see “Configuring the AMG Journalist Server with AMG News Control” on 
page 50.

• Already installed, you must configure it for AMG News Control. To do so, continue with the 
topic “Configuring the AMG Journalist Server with AMG News Control” on page 50.

Even if the AMG Journalist Server has been configured initially, it still must be installed and 
configured the for use with AMG News Control.

Configuring the AMG Journalist Server with AMG News Control

After installing, the Avid Motion Graphics Journalist Server components on your Journalist 
Server, they must be configured.

n  Installers for other related Avid Motion Graphics News components are opened from the AMG 
Journalist Server.

To configure the Avid Motion Graphics Journalist Server:

1. On the Avid Motion Graphics Journalist Server, navigate to: 
C:\AMGNews\bins\cfg\AMGConf.ini.

2. In the General section:

t Set VIDEO FRAMES to NTSC or PAL.

3. In the Preview Snaps section:

t Set the IP to the specific address for the local machine (do not use 127.0.0.1, or a host 
name).

4. In the Gateway section:

t Set the IP to the specific address for the local machine (do not use 127.0.0.1, or a host 
name).

5. In the MOS Device section:

t Confirm the NAME is set to set to your desired MOS DEVICE ID for the AMG playout 
system.
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6. In the Control section (where NAME = CTRL1):

t Set the IP address to the specific address on which AMG News Control will run.

7. In the Control section (where NAME = COMMAND1):

t For AMG News Control, comment out this entire section with a ;.

8. In the Render Sections (There are two.):

t Set the IP to the specific address for the AMG Playout Servers.

9. In the Manager section:

t Set the IP to the specific address for the AMG Journalist server (do not use 127.0.0.1, or 
a host name).

t For iNEWS, confirm that IS NCS is set to NO.

10. In the NCS section:

t In the NAME field, enter the iNEWS server name in the NAME.

t In the IP field, enter the IP address of the computer running the Avid MOS Gateway.

11. On the AMG Journalist Server, go to C:\AMGNews\bins\cfg\Previewunits.ini.

t In both IP fields, enter the IP address for where the AMG News Preview Renderer will 
be running.
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Licensing AMG News Control

Open Avid License Control on the AMG Journalist Server, and confirm that you have an NRCS 
license and AMG News Control licenses (if necessary). If you do not have an NRCS license, 
contact your sales representative to obtain a license.

To License Avid Motion Graphics News Control:

1. Open Avid License Control tool.

2. Activate the Avid Motion Graphics NRCS license.

n The license is most easily added with an internet connection, so that the computer can connect to 
the Avid license server and verify the license.
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Understanding the X: Drive Network Share

The AMG News system includes a network share folder known as the X: Drive. This is a 
centralized location where many of the components for the AMG News system reside. The X: 
Drive includes installers and configuration files for components. The X: Drive is also the 
centralized repository for the sites graphic templates and assets. It is vital that consistent network 
connectivity is available between AMG News components and the X: Drive. 

By default, the X: Drive is installed on the AMG Journalist Server as part of the AMG News 
installation. 

The following is the X: Drive directory structure overview.

• Bins — Include executable files for AMG News Components, cfg folder containing 
configuration ini files, plug-in folder containing plug-ins for use within Journalist client, and 
a log folder for log files.

• Bins\cfg — Contains ini files for configuration.

• Install — Installers for AMG News Components.

• TPL — Graphic templates for AMG News Project

• RSC — Shared assets for use as replaceable fields in AMG Journalist Clients.

• TPL_Example—An example news project with replaceable fields for testing

When this is this is done, there is an AMG News icon on the desktop. Double-click it to start the 
following AMG server applications:

• AMG News Licenser: gives out AMG Journalist client license seats

• AMG Gateway: manages communication between NRCS, database, and Avid MOS 
Gateway.

• AMG News Preview Server: manages Preview requests for Journalist Clients.

The install comes with a ‘basic’ project, that can be used for initial testing and confirmation.



AMG News Control Installation Tasks

54

Installing Avid Motion Graphics Journalist Client

The following steps describe how to install the Avid Motion Graphics Journalist client for 
integration with Avid Motion Graphics News Control. They assume that the Avid Motion 
Graphics servers have already been installed and licensed.

To install the Avid Motion Graphics Journalist client:

1. Navigate to the Avid Motion Graphics Journalist Server (via UNC path - 
\\servername\AMGNews).

2. Open the install folder.

3. Click AMGDriveMonitor to install.

This configures the X: Drive and configures the system tray icon.

4. Click AMGODBC to install. 

This configures the database connection.

5. Click the AMGNRCS to install. 

This configures the AMG Journalist Client.

Installing the AMG Preview Renderer

The following describes installing the Avid Motion Graphics Preview Renderer on a dedicated 
computer.

For baseline computer requirements, see an Avid Sales associate.

Before starting this procedure, the X-drive should be connected. Make sure the network drive is 
mapped as follows: \\***.***.***.***\AMGNews, where * is AMG Journalist server IP address.

To install the Avid Motion Graphics Preview Renderer:

1. Navigate to the X-drive (via UNC path - \\servername\AMGNews).

2. Open the Install folder.

3. Double-click the Avid_Motion_Graphics_Journalist_setup.exe.
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4. Select Yes. 

The User Account Control dialog box opens.

n The installer may detect some items already installed. If the menu item as a green check next to 
it, it is already installed and you can move on to the next step. In the example above, the first four 
items have already been installed.

5. In the AMG Journalist Applications window, click Avid Motion Graphics News Preview 
Renderer to install it.

6. Click Microsoft Visual C++ 2008 Re-distributable to install it.

7. Click the Avid Motion Graphics Drive Monitor to install it. 

8. You will need to enter the IP address for the Avid Motion Graphics Journalist server.

The Host name or IP address for the Avid Motion Graphics Journalist Server will appear in 
the AMG Drive Monitor dialog box. Follow the prompts, clicking Next, to proceed. Then, 
click Install. When finished installing, click Finish. 

9. Click Avid Motion Graphics ODBC to install it. Follow the prompts, clicking Install, and 
then click Next to proceed.

n A database password is not necessary, and should not be entered.

10. Click Avid License Control to install it.

11. Click Avid Motion Graphics News Preview Renderer to install it.
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12. Click Avid Motion Graphics Font Package to install it.

n If you planing to use Avid Deko compositions in AMG, you need to install Deko Player 6.3.0 and 
Deko Chart Designer 1.1.0. If you are not upgrading from Avid Deko you can skip these to 
installs.

13. Click Exit to close the installer licensing.

14. Open the Avid License Control tool.

15. Add the Preview Renderer licenses (Preview and Clips). If you do not have a Preview 
Renderer license, contact your sales representative to obtain a license.

n The license is most easily added with an internet connection, so that the computer can connect to 
the Avid license server and verify the license. 

Creating a Project Shortcut

Create a Start Menu shortcut to open the project in the Preview Renderer.

To create a project shortcut:

1. Navigate to X:\TPL\basic.ldr (or the specific project name).

2. Create a shortcut to that file on the desktop.

3. Double-click the file to open the project in Preview Renderer A.

4. With the project open, double-click the shortcut again, to open the project in Preview 
Renderer B.

This enables you to click Start, point to the Preview Renderer A, and select the project to 
open both Preview Renderers.

5. Navigate to the AMG Journalist Server.

t Click AMGDriveMonitor to install. This configures the x: Drive and configures the 
system tray icon

t Click AMGODBC to install. This configures the database connection.

6. Open Avid License Control.

7. Confirm that the AMG licenses are in place: AMG, Clips, 3D Stereo (if purchased).
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Configuring Avid MOS Gateway, AMG News Control and iNEWS

The last steps are to configure the MOS device channels, and iNEWS rundowns.

To Configure Avid MOS Gateway:

1. In iNEWS SYSTEM.MOS-MAP, add an entry for the new MOS ID. See the following 
example:

2. In iNEWS SYSTEM.MAP, add an entry for the MOS device and its corresponding MOS 
Gateway. See the following example:

3. Configure the Avid MOS Gateway – MOS devices controlled by the Avid MOS Gateway 
must appear as an entry in the Avid MOS Gateway’s mosconfig.xml file. See the following 
example:
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Configuring ENPS to Host the AMG Journalist Client

If you are using AMG Journalist with ENPS, then you must configure ENPS to host the AMG 
Journalist client. 

n This can be done from any ENPS client machine. 

Once configured, the AMG Journalist client will need to be installed (from the X: drive) on all 
ENPS client machines that need access to it.

To configure ENPS to host the AMG Journalist client:

1. Open the ENPS client.

2. Select the green 'rover' on the 4th folder in the client, point to System Maintenance, and then 
MOS Configuration.

3. If you already have a MOS ID configured for the Command system, add the following 
information to the respective fields:

a. In the Description field, if a description is already entered, it should be changed to 
AMG Journalist, so users can easily identify it.

b. In the IP field, type the IP address of the Command server, if not already done.

c. In the ActiveX field, type RCGPLUGIN.RCGpluginCtrl.1, which identifies the AMG 
Journalist client plugin.

d. In the Program field, select the group that was created specifically for Command.

e. In the MOS Version field, verify that 2.8 is the recommended version.

n Make sure that the AMGConf.ini is also set to use MOS 2.8.

f. In the Local DragDrop field, make sure it is set to Off.

g. In the Story Send field, make sure this option is selected.

n Using the same MOS ID as the Command system allows the journalist to open graphics that 
have already been created.

n If you are using more than one ActiveX plugin (such as AMG Journalist and Deko Select), only 
one ActiveX plugin can be configured to use the same MOS ID as Command. The second ActiveX 
plugin will need to be set up with a separate MOS ID.
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Confirming Avid Motion Graphics Journalist Functionality

After installing and configuring the Journalist and News Control components, confirm the 
functionality.

To confirm Journalist functionality:

1. Open the AMG Journalist client.

2. Double-click an item to open it in the template editor.

3. Add replacement data and click Save.

The new item should appear in the Graphic Database area list with a unique ID for the item.

4. Open the new item and edit the first replaceable field.

5. Click Save and confirm that the data has updated.

6. Open the created item and click the Preview button.

7. Confirm that the correct replacement data appears.

8. Open the created item and click the Movie button.

9. Confirm that the item appears with motions and correct replacement data.

10. Create several more items and drag them into a rundown.

11. Create a hand-entered item. Confirm that it appears in News Control.

12. Designate one of the items as a library graphic and drag into a playlist.

13. MON Load the show, and confirm that all graphics appear in the Avid Motion Graphics 
News Control Workstation.
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Example of AMGConf.ini File for AMG News Control

This topic contains an example of the AMGConf.ini configured for AMG News Control.

; This is the base file for AMG, iNews, and AMG News Control

;

[GENERAL]

"ENCODING"= "UTF8";UTF8 or ASCII

"VIDEO FRAMES"= "NTSC";PAL or NTSC, it is used to calculate the length of 
the graphics

"LOG FILES"= "3";Max num log files

"TEXT DB"= "P_TEXTS";Database that can be used to fill templates

"AUTO SLUG"= "MIXED";TRUE, FALSE or MIXED

"SLUG FMT"= "<tpl>:<id>";Format used to generate auto slugs

"AUTO SNAPS"= "FALSE";TRUE to enable auto snaps feature

"OBJ READY"     = "TRUE";TRUE if graphics must be created "Ready for Onair" 
by default

"WAIT ACK"= "FALSE";Wait for ACKS

"FORMAT"= "jpg";Snapshot format

"TPL EXTENSION"= "scn"

[PREVIEW SNAPS]

"NAME"= "SNAPS"

"IP"= "xxx.xxx.xxx.xxx"   ;AMG PreviewServer Application IP address 
(journalist server)

"PORT"= "6125" ;Port where to send the requests

"ACK PORT"= "5125" ;Port where the plug-in will get the answer
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"SNAPS PATH"= "X:\preview";net path where to find the snap files

"OBJS PATH"= "X:\preview\objs"  ;net path where to find the graphics images

"VIEW X-RES"= "400";Resolution used by the plug-in to show the

"VIEW Y-RES"= "225";generated snaps

"DICTIONARY"= "PreviewDICT";

;"EXPORT FMT"= "<date>_<time>_<user>"  ;patern to generate exported movie 
names

;"EXPORT PATH"= "";SNAPS PATH will be used if this is not defined

;"EXPORT MASTER" = "USER" ;USER or SERVER. Who copies the final file to 
EXPORT_PATH

[GATEWAY]

"NAME" = "GW1"   ;This name will be used by other components

"IP" = "xxx.xxx.xxx.xxx"    ;AMG Gateway Application IP address (journalist 
server) 

"NCS UPPER PORT" = "10441"   ;MOS Protocol Ports (default ports)

"NCS LOWER PORT" = "10440";Just leave this alone

"MOS UPPER PORT" = "10541";Just leave this alone

"MOS LOWER PORT" = "10540";Just leave this alone

[MOS DEVICE]   ;THIS DEVICE IS FOR NEWS CONTROL

"NAME"= "MSNAMG2";MOS name for AMG Playout server (this needs to match MOSID 
in

; system.map and system.mos-map file)
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"GATEWAY"= "GW1"   ;Gateway that creates content for this Render Unit

"TPL FOLDER"= "X:\Tpl"   ;Net path where the templates can be found

"RSC FOLDER"= "X:\RSC"   ;Net path where resources used to create graphics 
can be found

"OBJ FOLDER"= "P_RENDER2"   ;Just leave this alone

"DB TYPE"= "ODBC"   ;System used to manage the graphics. FILE (deprecated) 
or ODBC. 

"VERSION"= "2.6"   ;Protocol Version. "2.6" or "2.8" for MOS, "CA" for 
ControlAir

"CHANNELS"= "1, 2"

[CONTROL]   ;THIS CONTROL SECTION IS FOR NEWS CONTROL

"NAME"= "CTRL1"   ;Name used by the Render Unit to reference this Controller

"MOS DEVICE"= "MSNAMG2"   ;Name used by the Gateway where the Controller 
sends commands

"IP"= "xxx.xxx.xxx.xxx" ;IP where the AMG News Control is running

"PORT"= "5130"   ;Protocol messages

"CONTROL PORT"= "5127"   ;Port where the Controller receive commands

"CHANNELA"= "Render1"   ;Name of the first Program channel (required)

"PREVIEWA"= "Render2"   ;Name of the first Preview channel (required)

"DICTIONARY"= "ServerDICT"

[RENDER]   ;NEWS CONTROL - Settings for the first Program channel(required)

"NAME"= "Render1"

"IP"= "xxx.xxx.xxx.xxx" ;IP address of AMG Chassis

"PORT"= "5124"   ;Just leave this alone
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[RENDER]   ;NEWS CONTROL - Settings for the first Preview channel(required)

"NAME"= "Render2"

"IP"= "xxx.xxx.xxx.xxx" ;IP address of AMG Chassis

"PORT"= "5124"   ;Just leave this alone

[MANAGER]   ;AMG News Licenser Application IP address

"NAME"= "MAIN"   ;Just leave this alone

"IP"= "xxx.xxx.xxx.xxx" ;keeps track of licenses for AMG clients

"PORT"= "5140"   ;Just leave this alone

"IS NCS"= "NO"   ;Use "No" for iNews or ENPS, "YES" for for stand alone

[NCS]   ;THIS NCS SECTION IS FOR NEWS CONTROL

"NAME"= "NRCS4"   ;iNEWS server name, ENPS server name or RCG Manager Name

"IP"= "xxx.xxx.xxx.xxx" ;IP address of iNews MOS Gateway or ENPS server

"AUTO ABSTRACT" = "TRUE"   ;Generate the abstract field for iNews and ENPS

"ABSTRACT FMT"= "<tpl>:<2values>" ;Format used to generate the auto 
abstract

"DB TYPE"= "ODBC"   ;it MUST be "ODBC". Only used in stand-alone mode

"DB PATH"= "P_NCS"   ;ODBC source name.

"VENDOR" = "MOS"   ;Speciall behaviour for some vendors [MOS, VSN]

;[DICTIONARY]
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;"NAME"= "MyDICT"

;"REPLACE"= "X:\RSC >> D:\Playout\Clips"
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